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1 Introduction 

This document describes the most important aspects of the installation of Online Filing (OLF) version 5.00. 

Online Filing enables users to file patent applications under the EP, PCT and national procedures of the EPO, 
WIPO, and the national offices electronically, using secure Internet connections and state-of-the-art electronic 
commerce technology for secure transactions.  

Intended audience 

This guide is intended for administrators who are responsible for installing and providing support for Online Filing 
software in networks or on stand-alone PCs. 

Document structure 

 Section 2 (see "Installation overview" p. 6) provides an installation overview and describes the hardware and 
software requirements.  

 Section 3 (see "Performing installation" p. 15) describes the installation procedure for the following scenarios: 

 Initial installation (p. 21) 
 Making changes to an installation (p. 34) 
 Re-installation (p. 42), including prior uninstallation 

 Section 4 (see "Upgrading from OLF version 4.00 to version 5.00" p. 56) provides information for users 
updating from OLF version 4.00 to version 5.00. 

 Section 5 (see "Uninstalling Online Filing" p. 58) describes how to completely uninstall the Online Filing 
software. 

 Section 6 (see "Using the PMS gateway interface" p. 60) outlines the steps needed to use and configure the 
PMS gateway interface. 

 Section 7 (see "Troubleshooting" p. 63) covers troubleshooting and provides solutions to problems. 
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1.1 Legal notices 

Copyright 

© European Patent Office (EPO), 2009. All rights reserved. 

Accurate reproduction of EPO-created information contained in this documentation is authorised, provided the 
source is acknowledged and unless otherwise stated (e.g. that use is restricted or subject to prior permission). 

Further use of third-party works requires permission from the copyright holder, unless this is waived under the 
law applicable. 

Trademarks and logo 

The EPO's official logo is likewise protected worldwide as an emblem of an international organisation under the 
Paris Convention for the Protection of Industrial Property. 

Disclaimer 

EPO Online-Services and the associated data from EPO databases are regularly maintained and updated. Great 
care has likewise been taken in writing the instructions for using the services provided, to ensure that the 
information supplied is correct. Furthermore, the EPO makes every effort to prevent technical malfunctions. 
Given the amount of data and information provided, however, it is not possible to rule out all errors and 
omissions. 

The EPO therefore accepts no liability for the completeness and accuracy of the data and information made 
available in connection with these services, and it does not guarantee that the underlying files and the formats 
used are error-free and will not cause the user's systems to malfunction. Nor can the EPO guarantee that the 
information presented in this documentation about the functionality and use of these services is fully up to date, 
complete, and without any errors or mistakes. 

Other access conditions 

The EPO reserves the right to modify, extend or discontinue the available services, in full or in part, without prior 
notice. 

 

 

1.2 EPO User Support 

EPO User Support operates a helpdesk for Online Filing users. 

Open: Monday to Friday, 08.00 – 18.00 hrs CET 

Tel.: +31 (0)70 340-4500 

Fax: +31 (0)70 340-4600 

e-mail: support@epo.org (mailto:support@epo.org) 

Internet: www.epoline.org (http://www.epoline.org) 

 

mailto:support@epo.org�
http://www.epoline.org/�
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2 Installation overview 

2.1 How Online Filing works 

You can install Online Filing for two different modes of operation: 

 on a stand-alone PC, in other words, local installation of the OLF application server and the OLF thin client 
together on a single PC 

 in a network, in other words, distributed installation of the server and thin client(s) on multiple PCs 

Users operating a separate patent management system (PMS) can install Online Filing's PMS gateway interface 
on both a stand-alone workstation and a server in the corporate network. This gateway sets up a connection from 
the PMS to the receiving server installed on the office side and uses Online Filing mechanisms for data validation 
and transmission, see PMS gateway features (p. 61). 

 

Figure 1: Modes of installation for Online Filing software 
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2.1.1 Server and thin client in a single network 

Network (distributed) mode facilitates workflow synchronisation when there are multiple employees, departments 
or offices involved in the patent application process. 

The OLF server is installed at one of the applicant's sites, with one or more thin clients installed on the 
employees' networked PCs. The OLF server will run against the applicant database, ensuring that all users can 
access the same data and only one user can modify a specific record at a time.  

A smart card reader must be installed at all workstations so that forms can be signed using a personal smart card 
(digital signature) and applications can be submitted to a patent office. 

 

Figure 2: Networked environment 
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In a private network, the Online Filing system will allow a user in, say, Los Angeles to create and sign an 
application and for this application to be checked and submitted by an attorney in, for example, Cambridge, UK. 

In another example, a paralegal can create a ready-to-sign application which can then be approved and signed 
by an attorney using their own smart card, and finally sent by an assistant using their own smart card. The 
assistant can also receive the receipt. 

 

Figure 3: Individual steps in application submission workflow 

The progress of the application can be monitored at all times by all persons involved. 

 

Figure 4: Employees' clients connected to database 
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2.1.2 Communication via CORBA or SOAP 

CORBA communication 

For low-level communication between the Thin Client and the OLF Server within a LAN, the CORBA-IIOP 
protocol is preferable. At network level communication, the IIOP port (CORBA port) can be configured separately 
for the OLF File Manager and for every form (EP1001E2K, EP1200E2K, EP1038E, EPOPPO, PCT/RO/101, etc.) 

The ports are configured when installing Online Filing and can be changed afterwards in the File Manager 
configuration file, see CORBA and SOAP ports configuration (p. 13). 

SOAP communication 

If you are using Online Filing in a company with subsidiaries connected through a WAN, you may want to use 
SOAP communication instead of CORBA. Although small performance losses might occur as a result of the 
slightly reduced playback speed, this protocol will pass firewalls as communication is done with wrapped HTTP 
requests. 

Please note that SOAP is not compatible with the PCT procedure. CORBA is required for PCT. 
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2.2 Installation requirements 

2.2.1 Settings in MS Windows 

Windows user rights 

You need administrator rights to install the OLF server modules and to start the Online Filing Server Manager. In 
other words:  

 in Windows 7 and Windows Vista, you need an administrator password for certain tasks or you can log on 
with Administrator as the user account type. 

 in Windows XP, log on as a member of the Administrators group or with Computer Administrator as the 
user account type.  

You need enhanced user rights to install the thin client if you do not already have administrator rights: 

 in Windows 7 and Windows Vista, you need an administrator password for certain tasks. 

 in Windows XP, log on as a member of the Power Users group. 

The thin clients can be used with normal user rights, in other words, with the Limited user account type 
(Standard user in Windows 7 and Windows Vista) or by a member of the Users group. 

Service status in Windows 

The services used by Online Filing are programmed during installation to start automatically with Windows, see 
Checking and verifying the server PC (p. 64). Make sure that your system allows you to configure services that 
start automatically before you install them. 

Using remote-access software 

Remote-access software can generally be used without any problems. Select the /console option if working 
with Microsoft Remote Desktop. This option may appear as /admin, depending on the operating system used. 

Display settings in Windows 

The font size for the screen should be set to Normal or the default option, see Optimising the display 
settings (p. 67). 
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2.2.2 Hardware requirements 

To use the OLF Client version 5.00, your hardware should meet the following requirements: 

 

Minimum hardware requirements Recommended hardware requirements 

 Processor: Intel Pentium II processor (or 
equivalent), 500 MHz  

 CD-ROM drive (for CD installation only) 

 RAM: 512 MB 

 1 GB of available hard disk space 

 Monitor: VGA/SVGA/XGA/SXGA, 
resolution 800*600 

 Smart card reader connected to serial or USB 
port 

 Processor: Intel Pentium 4 processor (or 
equivalent), 2.4 GHz  

 CD-ROM drive (for CD installation only) 

 RAM: 1 GB 

 4 GB of available hard disk space 

 Monitor: VGA/SVGA/XGA/SXGA, 
resolution 1024*768 or higher 

 Smart card reader connected to serial or USB port 

 

! Note: PC memory (RAM) requirements depend on the size of the application to be filed and the 
processor speed. A PC with 1 GB RAM is recommended to avoid problems with larger file 
attachments (applications over 50 MB in total). If you are using Windows 7 or Windows Vista, even 
2 GB RAM is recommended to meet the operating system's requirements in an optimal way. 

 

 

2.2.3 Software requirements 

Operating systems supported 

The OLF software was tested on the following operating systems: 

 Microsoft Windows 2000 (SP4) 

 Microsoft Windows XP (SP3), 32-bit operating system 

 Microsoft Windows 2003 Server (SP3), 32-bit operating system 

 Microsoft Windows Vista (SP2), 32-bit operating system 

 Microsoft Windows 7, 32-bit operating system 

 Microsoft Windows 2008 Server, 32-bit operating system 

Fonts 

Online Filing requires the Arial Unicode MS (TTF) font for both the server installation and the stand-alone 
installation (local installation). This font is automatically installed with the MS Office package.  

The font is also available for license from Ascender Corporation 
(http://www.ascendercorp.com/msfonts/arial_unicode.html). 

http://www.ascendercorp.com/msfonts/arial_unicode.html�
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Additional Software for the thin client 

The following software should be pre-installed on the computer that you want to operate for the OLF thin client or 
stand-alone version: 

 Adobe Acrobat Reader, version 7.x, 8.x or 9.x  (recommended) 

 Gemplus driver for the smart card reader 

 GemSAFE Libraries 4.2.0 SP4 or higher for computers running Windows XP or Windows Server 2003 

 GemSAFE 5.2 Patch 1 for computers running Windows 7 or Windows Vista 

The above software is not required if you only want to use your OLF server as a server, in other words, if you do 
not install any OLF clients on the same computer. 

You can download the software packages for the installation from the EPO's Online Services 
(http://www.epoline.org) website or obtain a CD from the EPO containing the start package for Online Services. 
The CD comes with an installer tool that will guide you through installing all the software and drivers required for 
your machine. 

 

 

2.2.4 Network settings 

The installation currently assumes a fixed IP address of the OLF application server machine and that the 
computer network identification can be put in the OLFfm.conf file with the following attribute:  

IPAddress=<IP Address> 

! Note: The thin client also needs to point to this address.  

If you are using a dynamic IP address please contact EPO User Support for more information 

Running a HTTP Web server at the same time 

To ensure that the OLF client 5.0 works properly, there should be no HTTP server installed on the OLF server or 
local machine because otherwise the Help files might not be available. The reason for this is that the OLF client 
runs its own HTTP server on port 80 for displaying the online help. On the stand-alone it is on the same machine, 
while in a network installation you will find it on your OLF server. If another Web server (for example IIS, Apache, 
Xitami, IBM HTTP server, etc.) is already running on the machine where the OLF client 5.0 system is installed, 
the Online Filing installation program automatically chooses another port, i.e. 88.  

Proxy configuration 

If you are using a proxy server, your OLF server has to be configured to point to a proxy server (and to a specific 
port) to access the EPO's receiving server over the Internet. Please enter the settings corresponding to the ones 
in your Internet browser. 

 

http://www.epoline.org/�
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2.2.5 CORBA and SOAP ports configuration 

Configuration of the CORBA and SOAP ports (for communication between the thin client and the applicant side 
server) is usually done at installation time; see Setting CORBA and SOAP ports (p. 25). Each form has to have 
a unique communication port for the thin client in order to connect to it. The ports in question must be free from 
use by other processes on the machine.  

! Note: For local (stand-alone) installation, all communication is done by CORBA. The OLF software 
is configured in such a way that it rejects any connection attempt using one of the SOAP ports on 
a stand-alone installation. 

If you need to re-configure one or more of the CORBA or SOAP ports after installation is complete, you can do 
this in the respective configuration files.  

You will find these .conf files in the corresponding folders in the installation directory, e.g. Program 
Files\EPO_OLF5\fm\config\ or Program Files\EPO_OLF5\ep1001\config\. 

 OLFfm.conf for the EPO OLF FM service, i.e. File Manager 

 ep_oppo.conf for the EPO OLF EPOPPO service, i.e. Form EP(Oppo) 

 ep1001.conf for the EPO OLF EP2000 service, i.e. Form EP(1001E2K) 

 ep1200.conf for the EPO OLF EP122K service, i.e. Form Euro-PCT(1200E2K) 

 ep1038.conf for the EPO OLF EP1038 service, i.e. Form EP(1038E) 

 pcti.ini for the EPO OLF IBR101 service, i.e. Form PCT/RO/101 (located under Program 
Files\EPO_OLF5\pct\) 

In the configuration file, the key "CorbaPort=" or "SOAPPort=" respectively should be assigned to the 
chosen port number.  

Examples 

For File Manager in OLFfm.conf file: 

# Corba protocol port number 

CorbaPort=11000 

# SOAP protocol port number 

SOAPPort=21000 

 

For EPO OLF EP122K in ep1200.conf file: 

# Corba protocol port number 

CorbaPort=11106 

# SOAP protocol port number 

SOAPPort=21106 

 

! Note: Few antivirus software products can detect the use of these high ports, suggesting malign 
software or a Trojan horse has infected your system. Please configure your antivirus software or 
firewall accordingly so as to allow the plug-ins to use these ports. 
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2.3 Using Online Filing on various Windows versions 

EPO Online Filing version 5.00 runs on all present versions of Windows, however, some specific issues for each 
version should be considered. 

Windows XP SP3 and Windows Server 2003 SP3 

There are no limitations for users of Windows XP and Windows Server 2003. In this manual, Windows 7 is used 
to demonstrate the setup and installation of Online Filing. Basically, the functionality on Windows XP and 
Windows Server 2003 is the same. Some of Windows' proprietary system functions can be found under other 
terms in the Control Panel, e.g. the Windows 7 Programs and features group is labelled Add or Remove 
Programs in Windows XP. We point out any differences where appropriate. 

The OLF thin client can be installed both with the OLF500client.msi installer package or the 
OLF500client.exe installation file. 

Windows Vista SP2 

Online Filing version 5.00 runs on Windows Vista SP1 and SP2 (32-bit system). Please read the special notes 
provided below on installing the OLF thin client or the OLF server on a computer running Windows Vista. In 
general, Windows Vista without Service Pack 1 or Service Pack 2 is not supported.  

The Local Installation option is not possible in Windows Vista; see Installing a stand-alone version (local 
installation) (p. 33). If you want to operate Online Filing as a stand-alone version, first install the OLF server and 
then the thin client on the same computer. Enter localhost or the IP address of the server under Online Filing 
5.0 Client Settings. 

Windows 7 and Windows Vista SP2 

The thin client should only be installed with the OLF500client.exe installation file, not the msi file. Windows 
Vista and Windows 7 do not support installation with the msi package and terminate the operation with an 
appropriate error message, see Thin Client installation (p. 30). 

Using the smart card and smart card reader requires the GemSAFE 5.2 software, see Software requirements 
(p. 11). 

For security reasons, Windows 7 and Windows Vista only allow users with Windows administrator rights to 
perform certain installation steps. The User Account Control window appears in these instances. Click Yes 
(Windows 7) or Continue (Windows Vista) if you are logged on as an administrator. If not, you must enter a 
Windows administrator password here; see Settings in MS Windows (p. 10) and Starting installation (p. 18). 

Windows Administrator rights are also needed to operate Server Manager, which can be started by right-clicking 
the shortcut icon; see Testing the installation (p. 55). 

Windows Server 2008 

Online Filing runs on Windows Server 2008 (32-bit) in the same way as on Windows 7 (32-bit). 

However, it cannot be installed on systems running Windows Server 2008 R2 (64-bit). 
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3 Performing installation 

The following section describes how to install OLF version 5.00 on Windows 7. Any deviations from this 
procedure for installation on other Windows versions are indicated at the appropriate place in the text.  

Possible installation scenarios 

 Read the section Initial installation (p. 21) if you have never installed any earlier versions of Online Filing on 
the target machine and you want to install version 5.00 for the first time.  

 If you want to operate Online Filing in a network, first install the server (see "Server installation" p. 21), 
followed by the thin client(s) (see "Thin Client installation" p. 30). 

 If you only want to operate Online Filing on a single PC, select Local installation (see "Installing a stand-
alone version (local installation)" p. 33). 

 If you want to make changes to your installation of Online Filing version 5.00, please read the chapter entitled 
Making changes to an installation (p. 34). 

 If Online Filing version 4.00 is installed on your computer and you would like to upgrade to version 5.00, 
please start by reading the chapter entitled Upgrading from OLF version 4.00 to version 5.00 (p. 56) and 
then follow the instructions under Making changes to an installation (p. 34). 

 In the event of a fatal system error that causes Online Filing to work with limited functionality or not work at all 
and forces you to re-install the software, please read the section entitled Re-installation (p. 42). 

 You should test whether Online Filing works following successful installation, see Testing the installation 
(p. 55). 
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3.1 Preparing for installation 

The following list summarises the steps involved in the installation procedure. You can use it as a checklist. 

1. Get the OLF version 5.00 distribution (for example from the Download centre on the EPO Online 
Services website (http://www.epoline.org)) or make use of the installation CD contained in the EPO 
Online Filing starter pack. 

2. Decide on the mode of installation you want, see Selecting the mode of installation (p. 20). 

3. If you have decided in favour of a network installation, make note of the server data such as IP address, 
CORBA and SOAP ports available, proxy settings etc. so that you have this data to hand during 
installation. 

4. Make sure the Arial Unicode font is installed on the target machine. You need this font for both server and 
client installation. Use a Microsoft Office installation CD and select the Universal font and the Additional 
True Type fonts under Office Shared Features in the Custom installation mode. Deselect all other MS 
Office components that you do not want to install. 

5. If using the downloaded installation file rather than the CD: install the Adobe Acrobat Reader 9.0 (if not 
already installed) and the Gemplus driver with corresponding libraries on the target client PCs. 

6. If upgrading from a previous version (OLF version 4.00), please read carefully section Upgrading from 
OLF version 4.00 to version 5.00 (p. 56) and take any necessary action. 

7. Give all network installation users ample warning of the impending disruption of Online Filing if you need 
to shut down the OLF server ahead of an upgrade. 

8. Start the installation and select the desired installation mode and type. 

9. Perform the individual steps as described in this guideline. You may be prompted to restart your computer 
(including the server). 

10. Verify the installation by filing an application to the OLF demo server of a filing office. 

 

http://www.epoline.org/�
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3.1.1 Using the installation CD 

The Online Services starter kit not only provides you with the Online Filing software and documentation, but also 
with all the other required software like Adobe Acrobat Reader, Amyuni PDF converter and Gem Plus smart card 
driver and software. It does not contain the Arial Unicode font, however. 

You can receive the starter kit after you enrolled for an Online Services user account on the EPO's Online 
Services website (http://www.epoline.org). 

The super installer running from the CD checks your computer and installs the missing (or outdated) software 
automatically. You are not required to cancel the installation of Online Filing in order to install other features first, 
which makes the installation procedure very comfortable. 

 Log on to the computer as a Windows administrator.  

 Insert the CD into your CD/DVD drive. 

 If AutoPlay is disabled on your machine, click the appropriate option in the AutoPlay window. 

The installer starts up automatically. 

 Follow the instructions on the screen. 

 Proceed to the next installation steps described in the section Starting installation (p. 18). 

For more information on installation from the CD, please refer to the booklet that came with your Online Services 
starter kit. 

 

 

3.1.2 Using the installation file 

Choose one of the following installation files to install Online Filing, depending on the mode of installation you 
opted for: 

OLF500.exe for server (network), local (stand-alone) or thin client (network) installation  

OLF500client.exe for installation of the thin client only 

OLF500client.msi for installation of the thin client only on Windows XP, especially for remote 
installation or automated software distribution in a network. This installation file 
should only be used for re-installation, not for updates. 

! Note: It is strongly recommended that you quit all Windows programs before starting the 
installation. If updating from an earlier version of OLF, please submit any pending applications 
first. 

 Log on to the computer as a Windows administrator.  

 Double-click the installation file.  

 Confirm the security warning: 

 Windows 7: Click Yes in the User Account Control window. 
 Windows Vista: Click Allow in the User Account Control window. 
 Windows XP: Click Run in the Security Warning window. 

 

http://www.epoline.org/�
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3.2 Starting installation 

Windows Installer starts the installation wizard.  

 

Figure 5: Wise Installation Wizard is initialised 

Selecting the language  

 Select the language for the installation process in the next dialogue box.  

The default setting is EN for English. 

 This language setting only applies for installation. The language of the Online Filing user interface is set 
directly in the software. 

 Click OK. 

 

Figure 6: Selecting the language for installation 
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 In the Welcome screen click Next. 

 

Figure 7: Welcome to the Installation Wizard 
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3.3 Selecting the mode of installation 

! The Local installation option is not active in Windows Vista and cannot be selected. 

Local installation Installs the stand-alone version (for users who only need the software on one PC) 

Server installation Installs the OLF server only (suitable for companies with multiple users in a 
networked environment) 

Client installation Installs the thin client only. 

 Select the installation mode you require. 

 Click Next. 

 

Figure 8: Selecting installation mode 
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3.4 Initial installation 

Read this section if you have never installed any earlier versions of Online Filing on the target machine and you 
want to install version 5.00 for the first time. 

 If you want to operate Online Filing in a network, first install the server (see "Server installation" p. 21), 
followed by the thin client(s) (see "Thin Client installation" p. 30). 

 If you want to operate Online Filing on a single PC only, select Local installation (see "Installing a stand-
alone version (local installation)" p. 33) . 

 

 

3.4.1 Server installation 

 Select Server installation as the mode of installation; see Selecting the mode of installation (p. 20). 

 Click Next. 

Specifying the destination folder 

The default program folder for installation is C:\Program Files\EPO_OLF5. 

 Click Next to use this destination folder. 

-OR- 
Click Browse to select a different folder for installation, for instance, on another drive.  

! Warning: Make sure the folder you select will only be used by Online Filing as it will be completely 
deleted in the event of uninstallation. If necessary, create a new folder on the destination drive. 
Never install the software directly in the root directory of a partition. 

 

Figure 9: Selecting the destination folder for installation 
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A warning appears if there is not enough disk space on the selected hard drive. If this happens, delete data to 
free up space on the hard disk or install Online Filing on another drive. 

 Click Cancel to terminate the installation process.  

 

 
3.4.1.1 Selecting the installation type 

The Typical option installs the complete set of services for File Manager, Server Manager, the EP procedures 
EP(1001E2K), Euro-PCT(1200E2K), EP(1038E) and EP(Oppo) as well as the PCT/RO/101 procedure.  

The Custom option also enables you to select national procedures, such as UK-Form 1, UK-NP1 and UK-Other 
Forms and Documents for filing with the UK Intellectual Property Office. For information on installing national 
procedures, refer to the chapter entitled Installing national plug-ins (p. 36). 

 Select the appropriate option. 

 Click Next. 

 

Figure 10: Selecting installation type 
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Confirming the settings for installation 

 Click Next in the Ready to Install the Application window. 

 If you are not sure you want proceed, you can click Back to check your settings and change them as 
required. 

-OR- 
Click Cancel to terminate the installation process. There are no system files copied to your computer at this 
point. 

The Updating System window appears and indicates the installation progress. 

 

Figure 11: Installation progress 
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3.4.1.2 Setting access authorisation 

Database access can be protected by assigning an Administrator and password. For the purposes of data 
security, this is highly recommended, as otherwise, any random user could modify important data and settings in 
Online Filing. 

The option for password protection is selected by default. 

 Enter the Password for the administrator and re-enter it for confirmation in the Confirm password field. 

 

Figure 12: Setting password protection for database access 

! If you select the option is not protected by password, user management will not be enabled later 
in Online Filing, which means that users will be able to start the software without entering a 
username. User management must be enabled if you want to activate the PMS gateway. 

You can enable user management afterwards in File Manager's system preferences and enter the password for 
the administrator.  

For detailed information on user management, refer to the user guide for Online Filing version 5.00. 
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3.4.1.3 Setting CORBA and SOAP ports 

You can change the CORBA and SOAP ports for the individual OLF services when installing the software, see 
also CORBA and SOAP ports configuration (p. 13). For example, the default CORBA port for the File Manager 
is 11000, the default SOAP port is 21000.  

 At present, SOAP is only available for Version 5 procedures. This is why there are no SOAP ports for the 
PCT procedure. 

 Modify the settings for CORBA and SOAP ports as required. 

 Click Next. 

 

Figure 13: CORBA and SOAP communication ports 
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3.4.1.4 Settings for network and proxy server 

If your network uses a proxy server to set up the Internet connection, you can enter the network settings here for 
application transfer and for the Live Update.  

 Enter an IP address or the name of the proxy server in the Proxy Server field and the number of the 
relevant proxy server port in the field after the colon.  

 If necessary, enter the username and password for logging on to the proxy server. 

 Select the encryption version used by your network in the SSL Version field. The default setting is SSLv3. 

 Modify the HTTP Port number if required.  

This port is going to be used by Online Filing to run its own web server for the Online Help pages to be 
accessed by the Online Filing thin clients in the network. The default setting is port 80. However, if the 
installation programme detects another web server already running on the same machine, it will assign a 
different port to Online Filing, i.e. 88. 

 Click Next. 

 

Figure 14: Network (proxy) settings 
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3.4.1.5 Setting the options for Live Update 

In the next window, select the countries for which Online Filing should search for and install updates using the 
automatic Live Update mechanism. You will receive new or updated plug-ins for the national procedures of the 
selected countries as soon as they are released by the EPO. 

 Select the countries that you are interested in. 

 Click Next. 

 

Figure 15: Selecting countries for Live Update 
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3.4.1.6 Completing the server installation process 

The system proceeds with the installation process. A message appears on the client installation once all data for 
the OLF server has been copied. 

The installation file for the thin client (OLF500client.msi or OLF500client.exe) is located in the installation 
directory C:\Program Files\EPO_OLF5\ThinClient_v500. 

 Click OK. 

 

Figure 16: Reminder for thin client update 

The following screen will be displayed to inform you that installation has been successfully completed. 

 Click Finish. 

 

Figure 17: Online Filing has been successfully installed 
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The EPO Online Filing program group is created in the Windows Start menu when installation is complete.  

 

Figure 18: Shortcut to the Server Manager in the EPO Online Filing program group 

You are prompted to restart the computer. 

 If you cannot see this window, it might be because it is hidden behind other windows on your screen. Use 
ALT+TAB to toggle between the windows. 

 Click Restart now. 

 

Figure 19: Prompt to restart your computer to complete the installation process 
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3.4.2 Thin Client installation 

In the thin client installation mode, only the Online Filing 5.0 Client component will be installed on the local 
machine. An OLF server should have been installed in your network before you install a thin client. For more 
information, see Server installation (p. 21). 

To install the thin client, you can either revert to the installation file OLF500.exe or use one of the two thin-client 
installation files (OLF500client.exe or OLF500client.msi) that can also be found in the program folder 
C:\Program Files\EPO_OLF5\ThinClient_v500 on the server PC following OLF server installation. 

 

Figure 20: Folder with installation files for the thin client 

Notice to system administrators 

Windows 7 and Windows Vista do not support installation with the .msi package and terminate the installation 
process with an error message. Use the .exe file instead. Most established automated software distribution 
systems are able to distribute this file type without difficulty. 

Add the following line when writing a batch file for the distribution of the .msi installer package: 

OLF500client.msi -quiet SOAP=1 host=localhost port=2100 

It is also advisable to use the .exe file instead of the .msi file for installation when updating existing OLF thin 
clients. When using the .msi package, you must first uninstall any older version of the thin client. Otherwise, the 
installation routine will output an appropriate message. 
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3.4.2.1 Starting thin client installation 

The following section describes how to install the thin client with OLFclient500.exe. 

 Log on to the computer as a Windows administrator. 

 Double-click the installation file. 

 Windows 7: Click Yes in the User Account Control window. 
 Windows Vista: Click Allow in the User Account Control window. 
 Windows XP: Click Run in the Security Warning window. 

Windows Installer starts the installation wizard.  

 

Figure 21: Wise Installation Wizard is initialised for the thin client 

Selecting the language  

 Select the language for the installation process in the next dialogue box.  

The default setting is EN for English. 

 This language setting only applies for installation. The language of the Online Filing user interface is set 
directly in the software. 

 Click OK. 

The Welcome to the Online Filing Client 5.0 Installation Wizard appears. 

 Click Next. 

Specifying the destination folder  

The default program folder for installing the thin client is C:\Program Files\EPO_OLF5-TC. 

 Click Next to use this destination folder. 

-OR- 
Click Browse to select or create a different folder for installation, for instance, on another drive. 

Confirming the settings for installation  

 Click Next in the Ready to Install the Application window. 

 If you are not sure you want to proceed, you can click Back to check your settings and change them as 
required.  

-OR- 
Click Cancel to terminate the installation process. There are no system files copied to your computer at this 
point.  

The Updating System window appears and indicates the installation progress.  
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3.4.2.2 Setting the connection to the server 

The Server address information window prompts you to enter the IP address of the OLF server component to 
which the thin client should set up a connection. You can select CORBA or SOAP as the method of connection 
for communication with the server.  

! Note: CORBA is recommended, since SOAP, due to its HTTP wrapping, will not be as fast as 
CORBA communication. 

 Enter the IP address or the computer name of your OLF server under IP Address.  

 Under Port, enter the port that you set for File Manager (EPO OLF File Manager) when installing the OLF 
server, see Setting CORBA and SOAP ports (p. 25). 

The default setting is 11000 in CORBA and 21000 in SOAP. 

 Click OK. 

 

Figure 22: Data for the connection to the server 

You can also enter or modify this data afterwards once installation is complete: 

 Open EPO Online Filing in the Windows Start menu and select EPO Online Filing 5.0 Client settings. 

This information can also be found in the OLFfm.conf file, see CORBA and SOAP ports configuration (p. 13). 

 

 
3.4.2.3 Completing the client installation process 

A screen will appear at the end of the process to inform you that the Online Filing client 5.0 has been 
successfully installed. 

 Click Finish. 

The EPO Online Filing program group is created in the Windows Start menu when installation is complete.  

You can start working with the OLF thin client immediately, without restarting your computer. 

 

Figure 23: Shortcut to the client in the EPO Online Filing program group 
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3.4.3 Installing a stand-alone version (local installation) 

In stand-alone installation, the Online Filing server and the Online Filing thin client are both installed on the same 
stand-alone computer. Following this type of installation, the OLF server cannot be accessed by other 
workstations, even if the computers are networked with each other. During installation, the client is automatically 
configured to point to the localhost address. 

! Note: The Local installation option is not active in Windows Vista and cannot be selected. Install 
the OLF server and the thin client one after the other, see Using Online Filing on various 
Windows versions (p. 14). 

Preparing for local installation 

 Log on to the computer as a Windows administrator.  

 Install the software required by Online Filing on the PC, see Software requirements (p. 11): 

 smart card infrastructure components 
 Arial Unicode MS font 
 Adobe Reader version 9.x (7.x and 8.x are also supported) 
- OR - 
Insert the starter kit CD into your machine's CD/DVD drive and follow the instructions given by the installer. 

The installation process 

Stand-alone installation is basically identical to server installation, but it also installs the thin client. 

 Start the installation with OLF500.exe, in case you did not make use of the installation CD. 

 Select the Local installation option as the mode of installation; see Selecting the mode of installation 
(p. 20). 

 Follow the instructions as described under Server installation (p. 21). 

When installation is complete, shortcuts are created in the Windows Start menu and you are prompted to restart 
your computer. 

 

Figure 24: Shortcut to the client and server in the EPO Online Filing program group 
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3.5 Making changes to an installation 

Read this section if you want to modify your installation of Online Filing version 5.00, for instance, to install or 
remove additional national procedures. 

 

 

3.5.1 Updating the server 

! Note: Before each server update, we recommend that you create a backup of the entire Online 
Filing database, see Database backup with Server Manager (p. 43). 

The following section describes by way of example how to install a national procedure at a subsequent time. The 
procedure for installing a patch is basically identical. 

 

 
3.5.1.1 Starting a modification 

 Start the installation program OLF500.exe on the PC with a local or server installation. 

If you have enabled user management in Online Filing, the installation program recognises that a password-
protected version of Online Filing is already installed. 

 Enter the password for the Administrator username. 

 Click Next. 

 

Figure 25: Entering the password for accessing an existing OLF installation 

 In the Welcome screen click Next. 

 Select Server installation as the mode of installation. 
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 Proceed through the ensuing steps until the Application Maintenance window appears. 

 Select Modify. 

 Click Next. 

 

Figure 26: Modifying the Online Filing installation 
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3.5.1.2 Installing national plug-ins 

Online Filing features are grouped in a tree structure during setup. Detailed Feature Description is displayed in 
the right pane when you click the name of a specific feature. 

For an overview of all national plug-ins, go to National offices on the EPO's Online Services website 
(http://www.epoline.org). 

In this example, the services EPO OLF UK, EPO OLF UKNP and EPO OLF UKSFD are to be installed. 

 

Figure 27: Selecting national procedures 

 Select and de-select items using the tree controls. 

 

Control Comment 

 Show child objects in tree. 

 Hide child objects. 

 Feature will be installed on local hard drive. 

 Feature will be installed with some of its child features. 

 Feature will be installed with all child features. 

 Feature will not be installed/will be uninstalled. 

 

 When you are done, click Next to continue. 

 Skip these steps if you do not want to install any national plug-ins. 

http://www.epoline.org/�
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3.5.1.3 Shutting down the server and services 

The installation program warns you that it will take some time to upgrade Online Filing. It is advisable to file all 
applications that are important or urgent before you start the upgrade. 

 Give all logged-on users ample warning (at the latest now) of the impending service disruption. 

 Click Next if there are no longer any applications still being processed. 

 

Figure 28: Warning before Online Services terminates 

 Click Yes in the ensuing message if there are no more users operating the OLF services. 

 

Figure 29: Previous installation detected 

 Confirm the InterBase server shutdown prompt with Yes. 

 

Figure 30: Shutdown InterBase (Firebird) Server 
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3.5.1.4 Updating the database 

The Database Update dialogue enables you to select which parts of the previous installation you want to have 
carried over. All options are selected by default. 

 Clear the check boxes beside the elements you do not want to have carried over to the updated database. 

 Click Next.  

 

Figure 31: Database update 

All selected components are now copied to a safe place, where they remain until installation is complete and they 
are copied back to the OLF database for later use. 

The copies of the production database (eOLFi.gdb) and the demo database (eOLFdi.gdb) will be stored in a 
new sub-folder in the Unload folder of the installation directory (default: C:\Program 
Files\EPO_OLF5\Unload). This new sub-folder is labelled with the creation date and time during installation, 
e.g. 20091109_130305.  

Please make sure that there is enough disk space available if your OLF database is already very large. You will 
need at least 600 MB of available hard disk space plus three times the size of the two databases (eOLFi.gdb 
and eOLFdi.gdb). 

The installation process first deletes all data in the database and then reloads it. 

 

Figure 32: Update of database tables 
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3.5.1.5 Changing settings 

The following process enables you to change the settings for Online Filing. The windows are identical to those 
that appear during initial installation. For an explanation of the individual steps see Server installation (p. 21). 

Access authorisation 

 Change the password for the administrator as required in the Online Filing Access window; see Setting 
access authorisation (p. 24). 

 Click Next. 

CORBA and SOAP ports 

Installing a national plug-in creates new services, in this example, EPO OLF UK177E, EPO OLF UKNPUK and 
EPO OLF UKSFD; a separate CORBA and SOAP port is available for each of these services. 

 Change the relevant port numbers as required. 

 Click Next. 

 

Figure 33: CORBA and SOAP ports 

Network settings 

 Change the data for access to the proxy server as required, see Settings for network and proxy server 
(p. 26). 

 Click Next. 
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Settings for Live-Update 

If new national procedures have been installed, you should now specify whether Live Update should 
automatically search for updates for these procedures too. 

 Select all countries that qualify for your installation. 

 Click Next. 

 

Figure 34: Selecting additional countries for Live Update 

After this, the system is updated and the database is repopulated with the previously exported data. The 
progress indicator lets you monitor the installation progress. 

The EPO Online Filing program group in the Windows Start menu is updated when installation is complete.  

The message about thin client installation is displayed as a reminder. 

 Click Finish in the final screen. 

You are then prompted to restart your computer now. 
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3.5.2 Updating the thin client 

Your thin clients may also need to be updated after you modify the server installation during major changes to the 
Online Filing software. 

Use the installation file OLF500client.exe or OLF500client.msi in the program folder C:\Program 
Files\EPO_OLF5\ThinClient_v500 on the server PC for this. Alternatively, you can download the 
installation files from the Download centre on the EPO's Online Services website (http://www.epoline.org). 

 Start the installation program as described under Thin Client installation (p. 30) and perform the initial 
steps. 

 Select Modify as the installation activity you want. 

 Click Next. 

 

Figure 35: Modifying thin client installation 

 Change the OLF server connection data as required, see Setting the connection to the server (p. 32). 

 Click OK. 

 

Figure 36: Data for the connection to the server 

 Click Finish in the final window. 

The thin client update is now complete. 

http://www.epoline.org/�


Online Filing 5.00 - Installation Guide 
 

Page 42 of 73 

 

3.5.3 Updating the stand-alone version 

The procedure for updating the server is largely identical for a server PC in a network and a stand-alone 
computer running a local installation. 

 Start the installation program as described under Starting a modification (p. 34). 

 Perform the individual steps. 

 Select Local installation as the mode of installation. 

 Perform the various steps as described in the relevant sections under Updating the server (p. 34). 

 Finally, restart your computer. 

 

 

3.6 Re-installation 

Please read this section in the event of a fatal system error that causes Online Filing to work with limited 
functionality or not work at all and forces you to re-install the software. 

! Important: When re-installing, you must ensure that you re-install the same build of Online Filing 
(including all patches) that you were working with previously. Failure to do so may lead to 
inconsistencies in the data. 

We recommend the following procedure for re-installing Online Filing: 

1. Save your data with Server Manager's Backup and/or Export function, see Backing up data (p. 43). 

2. Uninstall the OLF server, see Uninstalling the server (p. 46). 

3. Remove any remaining program folders, see Removing OLF program files and folders (p. 48). 

4. Remove the entries from the Windows registry, see Editing the Windows registry (p. 49). 

! Attention: This should be carried out by knowledgeable personnel or with assistance 
of such, due to the nature of the registry. 

5. Download the latest software package for the installation from the EPO website, see Re-installing the 
latest version of the software (p. 52). 

6. Re-install the OLF server, see Server installation (p. 21). 

7. Restore your data with Restore and/or Import, see Restoring data (p. 53). 

8. If necessary, update all thin clients, see Updating the thin client (p. 41). 
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3.6.1 Backing up data 

We recommend that you create a backup of the database and save your data manually before you uninstall the 
Online Filing software. 

! Warning: It is not advisable to simply copy the databases eOLFi.gdb (production) and 
eOLFdi.gdb (demo) to another storage location and then copy them back to the EPO_OLF5 
program directory after re-installation. However, in an emergency you could use a copy of the 
database - for example one created by an automatic system backup - as long as no changes had 
been made to the Online Filing software since the backup was performed. 

Backing up the entire database with Server Manager's Backup function 

The database backup function carries out a full backup of all the Online Filing data. All applications and 
templates, including all items in the Trash folder, are backed up. This option also backs up the Address Book, the 
user management settings, the File Manager folders and the folder management settings. 

Backing up applications and templates manually with Server Manager's Export function 

Use this method in the event of problems with the database and if the Server Manager's Backup function does 
not work. 

Backing up the Address Book manually with File Manager's Export function 

The Address Book can be exported as a CSV file and then re-imported later as required. 

 

 
3.6.1.1 Database backup with Server Manager 

 Start the Online Filing Server Manager. 

 In Windows 7 and Windows Vista, right-click the Online Filing 5.0 Server Manager shortcut in the 
Windows Start menu and select Run as administrator from the context menu. 

 Login with your Online Filing user name and password. 

 You need to login with an Online Filing user account that is member of the Administrators group. Other 
users, even if their profile provides the identical user rights, cannot login to Server Manager. See also note on 
Using remote-access software (see "Settings in MS Windows" p. 10). 

 Click the Settings tab in order to modify the settings for the location of your backup files. 

The standard location for backup files is C:\Program Files\EPO_OLF5\tools\smanager\data. As the 
complete EPO_OLF5 installation folder is going to be overwritten later during the installation process (or removed 
during uninstallation), you should change that path to an external folder, preferably on a hard drive different from 
your system drive.  



Online Filing 5.00 - Installation Guide 
 

Page 44 of 73 

 Click the folder button next to the path named Backup and restore directory. 

 
 Select the location for your backup files and click OK when you are done. 

 

Figure 37: Settings for the backup and restore directory in Server Manager 

In this example, there is a backup folder named Backup_DB created on the network drive Z. This folder will now 
be used by the Server Manager to store backups. 

 Click the Backup tab. 

 Select Action > Backup from the menu or click the Backup icon. 

 

Figure 38: Starting backup of database in Server Manager 

A dialogue box will appear prompting you to select either the production database or the demo database for 
backup. 

 Please back up both production and demo databases.  

 

Figure 39: Selecting database for backup 

A message will inform you when the action has been completed. 
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This is how the Backup tab in Server Manager looks after successful backup: 

 

Figure 40: Backup of production and demo database successful 

 

 
3.6.1.2 Backing up selected data with Export 

! Please note that you can only back up the user management settings in Online Filing, the 
individual folders in File Manager and folder management if you created a backup of the database. 

Exported applications, templates and address books can be individually imported at a subsequent point in time. 
For detailed information on the Export and Import functions, refer to the user guide for Online Filing version 5.00.  

Exporting applications and templates with Server Manager 

 Start the Online Filing Server Manager. 

 Select a directory in your file system as the default export directory, see Database backup with Server 
Manager (p. 43). 

 Click the Export tab. 

 Select the All Applications folder on the left.  

This folder contains all applications as well as all templates. 

 Click the  icon in the column headers on the right to select all applications and templates. 

 Click the Export button. 

 
A ZIP file is created in the default export directory for every application or template. 

Exporting the Address Book with File Manager  

 Start the Online Filing client, in other words, File Manager. 

 Click the Address Book button. 

 
 Select File > Export. 

 Select the relevant storage location and click Save. 

The Address Book is saved as a CSV file. 
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3.6.2 Uninstalling the server 

Windows 7 and Windows Vista 

 Open the Windows Control Panel. 

 Go to Programs > Programs and Features > Uninstall or change a program. 

 Select Online Filing 5.0 and click Uninstall/Change. 

 

Figure 41: Uninstalling the Online Filing software in "Uninstall or change a program" in Windows 7 and Windows Vista 
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Windows XP 

 Open the Windows Control Panel. 

 Go to Add or Remove Programs > Change or Remove Programs. 

 Select Online Filing 5.0 and click Change/Remove. 

 

Figure 42: Uninstalling the Online Filing software in "Add or Remove Programs" in Windows XP 

The uninstallation routine starts.  

 

Figure 43: Wise Installation Wizard is initialised for the uninstallation routine 

 Click Next in the Online Filing Uninstall window. 

The uninstallation progress is indicated in the Perform Uninstall window. 

 Click Finish in the Online Filing has been successfully uninstalled window. 
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 Confirm the prompt to delete the EPO_OLF5 folder with Yes. 

 

Figure 44: Prompt to delete the Online Filing program folder 

If you cannot see the prompt, it might be because it is hidden behind other application windows on your screen. 

 Restart your computer after uninstalling has completed. 

To uninstall the stand-alone version, proceed exactly as described for uninstalling the OLF server. 

 

 

3.6.3 Removing OLF program files and folders 

! Attention: Deleting system files may lead to an unstable operating system and is recommended 
for experienced users only, at their own risk. 

The OLF installation folder may remain on your computer after uninstalling the OLF software. You may also find 
other individual folders from earlier installations, such as epoline3 or EPO_OLF folders from older OLF 
versions. OLF version 5.00 uses the following installation path by default: C:\Program Files\EPO_OLF5. 

 Check Windows Explorer to see if you can still see the EPO_OLF5 folder after you restart the computer. 

 Delete the entire remaining EPO_OLF5 folder. 

 Delete the EPO_OLF5-TC folder, too, if you can still see it after uninstalling the thin client. 

 Delete the folders epoline3 and EPO_OLF, if shown. 

 Delete the files GDS32.dll and fbclient.dll, if shown in the directory WINDOWS\system32. 

With this version of OLF, no other files will be copied to the WINDOWS, WINDOWS\sys, WINDOWS\system or 
WINDOWS\system32 directories. 
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3.6.4 Editing the Windows registry 

! Attention: Editing the registry may lead to an unstable operating system and is recommended for 
experienced users only, at their own risk. 

Even after uninstalling the software within Windows, there may still be entries in the Windows Registry that need 
to be removed.  

Please open the Registry editor to check your Windows registry. 

 Open the Windows Start Menu and select Accessories > Run. 

 

Figure 45: Windows Start menu - Run 

 In the Run dialogue box, type the command regedit. 

 

Figure 46: Entering "regedit" command 
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Remove the EasyTeam keys 

 In the Windows Registry Editor, use either Edit > Find or press CTRL + F.  

 Enter EasyTeam as the search term and click Find Next. 

 Press F3 to search again for the same term. 

The registry contains at most the following two keys with an eOLF5 subfolder, and possibly also an eOLF4 
subfolder from an older OLF installation: 

HKEY_LOCAL_MACHINE\SOFTWARE\EasyTeam 
HKEY_CURRENT_USER\Software\EasyTeam 

 Delete both keys by right-clicking the folder EasyTeam on the left and then selecting Delete from the 
shortcut menu or hitting the DEL key. 

 

Figure 47: EasyTeam key in the registry 

If you have installed PCT-Safe from WIPO, there will also be an entry for WIPO inside the EasyTeam folder.  

 If that is the case, you should only delete the eOLF5 sub-folder. 

Remove the keys to start the MClient.exe 

 Search the Windows registry for MClient. 

 Delete the following keys one after the other by right-clicking the parent folder on the left and then selecting 
Delete from the shortcut menu: 

HKEY_CLASSES_ROOT\CLSID\{D4535D47-30E5-48AA-9901-5B5566E90BF4} 
HKEY_CLASSES_ROOT\Interface\{1EF9E2A1-A05F-4237-9499-34E0802338EE} 
HKEY_CLASSES_ROOT\MCorbaClient.GUICOMClient 
HKEY_CLASSES_ROOT\TypeLib\{0DDBDCE7-8EDD-4C1A-ACEA-69D1D83AA7CA} 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{D4535D47-30E5-48AA-9901-5B5566E90BF4} 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\TypeLib\{0DDBDCE7-8EDD-4C1A-ACEA-69D1D83AA7CA} 
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Figure 48: Deleting registry keys for MClient.exe 

Delete keys for ClientAdvise (cl_cm.mtdORBClientAdvise) 

HKEY_CLASSES_ROOT\CLSID\{4ECCBBFD-E55D-43F9-9135-59C8943E6F61} 
HKEY_CLASSES_ROOT\Interface\{129B335F-837C-477D-B946-240C28BA316C} 

Deleting additional keys 

Depending on the prerequisites of your network or your stand-alone system, the registry may contain additional 
keys that have to be deleted: 

 File Manager, EPO_OLF_FMMNGR_Service (OLFfm.exe) 

 Server Manager, EPO_OLF_FMGRDN_Service (OLFGuardian.exe) 

 Form EP(1001E2K), EPO_OLF_EP2000_Service (ep1001.exe) 

 Form Euro-PCT(1200E2K), EPO_OLF_EP122K_Service (ep1200.exe) 

 Form EP(1038E), EPO_OLF_EP1038_Service (ep1038.exe) 

 Form EP(Oppo), EPO_OLF_EPOPPO_Service (ep_oppo.exe) 

 Form PCT/RO/101, EPO_OLF_IBR101_Service (pcti.exe)  

 Other national plug-ins. 

If you had installed Online Filing Version 5.0 as an upgrade of Version 4.0, the registry may also contain several 
keys relating to the previous Online Filing Version 4.0 services. These keys should also be deleted: 

 Form EP(1001E), ep1001e.exe 

 Form EP(1001E) EPC 2000, ep1001e_2000.exe 

 Form Euro-PCT(1200E), ep1200e.exe 

 Form Euro-PCT(1200E) EPC 2000, ep1200e_2000.exe 

 Form EP(1038E) EPC 2000, ep1038e_2000.exe 

 

! Note: After cleaning the Windows registry, you need to reboot your computer for the changes to 
take effect. 

 



Online Filing 5.00 - Installation Guide 
 

Page 52 of 73 

 

3.6.5 Re-installing the latest version of the software 

In order to make sure that you have the most recent version of the Online Filing software available, we 
recommend that you download it from the EPO website, rather than use a (possibly outdated) installation CD. 
Visit the OLF portal at the EPO Online Services website (http://www.epoline.org). 

 Select Download centre on the left-hand side, then Software and Download the Online Filing related 
software.  

 Download the package for the installation of Online Filing version 5.00. 

Re-installing Online Filing 

 Perform the required installation procedure as described under Performing installation (p. 15). 

 Network version: First install the server, then restart the computer and finally install thin clients. 
 Stand-alone version: Perform local installation (not possible in Windows Vista), then restart the 

computer. 

Installing patches  

 Visit the Download centre to check if new patches have been issued by the EPO in the meantime and 
download them as necessary.  

 New patches are also announced on the website in the Hot News section. 

 Install the patches either manually or via Live Update in Server Manager. 

 For information on how Live Update works, refer to the user guide for Online Filing version 5.00. 

 

http://www.epoline.org/�
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3.6.6 Restoring data 

Once you have completed the installation, your database will be empty. Server Manager enables you to restore 
your complete database or import individual applications or templates.  

 

 
3.6.6.1 Restoring the database with Server Manager 

Use the Restore function to restore a backup of the OLF database with all user administration settings and File 
Manager folders. 

 Start the Online Filing Server Manager.  

 Go to the Settings tab. 

 Modify the backup and restore directory in order to set it to the same directory that you had previously 
used to back up your database. In the example below, the directory Backup_DB on the network drive Z has 
been specified. 

 

Figure 49: Modifying settings for the backup and restore directory in Server Manager 

 Click the Backup tab.  

 Select the backup you would like to restore (Demo or Production) and use either Action > Restore from the 
menu or click the Restore icon. 

 

Figure 50: Selecting backup file for restoring the database 

A message will inform you if the restore has been successful. 
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3.6.6.2 Importing selected data 

 For detailed information on the Export and Import functions, refer to the user guide for Online Filing version 
5.00.  

Importing applications and templates with Server Manager 

! Note: After the import, all applications that have not yet been sent are switched to Draft status in 
File Manager. In other words, you have to sign them again as required so they are ready to send 
before you can file them. 

 Start the Online Filing Server Manager.  

 Select a folder as the default import directory as described above for the restore directory, see Restoring the 
database with Server Manager (p. 53). 

 Click the Import tab. 

Available applications and templates are displayed. 

 Select the All Applications folder on the left. This folder also contains all templates. 

 Click the  icon in the column headers on the right to select all applications and templates.  

 Click the Import icon. 

 
The ZIP files previously created are unzipped and imported.  

 Applications in Draft status are automatically imported into the Default folder in File Manager. Templates 
are automatically imported into the Templates folder. 

Importing the Address Book with File Manager 

 Start the Online Filing client, in other words, File Manager.  

 Click the Address Book icon. 

 
The Address Book is empty. 

 Select File > Import. 

 Select the location where the previously exported CSV file is saved and click Open. 

 Follow the software instructions for the import. 
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3.7 Testing the installation 

The EPO Online Filing program group is created in the Windows Start menu when installation is completed 
and, depending on the mode of installation, contains shortcuts for starting the Online Filing components: 

 Online Filing Client 5.0 and Online Filing Client 5.0 settings for the thin client 

 Online Filing 5.0 Server Manager for the server 

 Online Filing 5.0 und Online Filing 5.0 Server Manager for the standalone installation. 

Test whether your Online Filing installation is working properly by starting the application. 

Starting Online Filing in a local installation 

 Go to the Windows Start menu and select:  

Programs > EPO Online Filing > Online Filing 5.0 

Starting a thin client in a server installation  

 Go to the Windows Start menu and select:  

Programs > EPO Online Filing > Online Filing Client 5.0 

Starting Server Manager in a local or server installation running Windows 2000/XP 

 Go to the Windows Start menu and select: 

Programs > EPO Online Filing > Online Filing 5.0 Server Manager 

Starting Server Manager on Windows 7 or Windows Vista 

 Go to the Windows Start menu and select: Programs > EPO Online Filing > Online Filing 5.0 Server 
Manager. 

 Right-click the Online Filing 5.0 Server Manager shortcut. 

 Select Run as administrator in the shortcut menu. 

If you are not the Windows administrator, you must now enter his or her Windows username and password. 

 Click Yes in the User Account Control window (Allow in Windows Vista). 

The Server Manager login window then appears. 

Sending an application to the demo server  

 Start File Manager in demo mode from a client PC. 

 Create a new application, for instance, with the Form EP(1038E). 

 Attach a document. 

 Sign the application digitally by inserting your smart card into the reader connected to the workstation. 

 Send the application to the EPO's demo server. 

If no errors occur during the transfer operation and you receive your demo acknowledgment of receipt, everything 
is in order. 
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4 Upgrading from OLF version 4.00 to version 5.00 

Please read the following information if you are using Online Filing version 4.00 and want to upgrade to version 
5.00. If required, perform all preparatory steps described below before you install version 5.00. 

! Note: You cannot revert to version 4.00 after installing version 5.00. 

Compatibility with older versions 

Online Filing can be upgraded to version 5 from builds 4.228 or 4.229 of the version 4 File Manager. The build 
number can be found in the File Manager info pane, under the menu option Help > Info. 

 If necessary, use the Live Update function in Server Manager to update version 4.00. 

When you install version 5.00 all data from the previous version will be safely migrated.  

Upgrading the thin clients to version 5.00 

Users with a client-server network should proceed as follows:  

 Install the thin client version 5.00 in addition to the thin client version 4.00 on all relevant computers.  

At this stage, you will still be able to file using Online Filing version 4.00.  

 As soon as you have installed all the thin clients for version 5.00, upgrade the server computer to version 
5.00.  

You can then no longer file via the thin clients of version 4.00.  

 Uninstall the thin clients for version 4.00.  

Applications still being processed 

You should complete all applications in version 4.00 and send them to either the EPO or the relevant designated 
office before you carry out the upgrade. 

Templates 

Update all version 4.00 templates with the most recent fee schedule, if not yet done. 

Applications in the Trash folder 

The Trash folder in File Manager must be empty before you install version 5.00, otherwise the installation 
process will terminate. Check if you still need any of the data in the Trash folder and, if not, empty it completely. 

Version 4.00 applications with forms that are not compliant with EPC 2000 

Applications based on the Forms EP(1001E) and Euro-PCT(1200E) can no longer be viewed in OLF version 5.00 
while this was still possible in version 4.00. If you need data from those applications for your reference, export the 
forms from File Manager. Before upgrading to version 5.00, delete the "old" applications from your version 4.00 
database after archiving them in an appropriate way. 
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Administrator password 

If you have enabled user management in Online Filing, a password must be set for the administrator, otherwise a 
message appears during installation to indicate that the password is incorrect. Log on to File Manager as an 
administrator to check the password or, where necessary, reset it. 

Program folder of an earlier version 

The EPO_OLF program folder used in the past might not be completely deleted during updates. If this happens, 
you should delete the folder manually as soon as you restart the computer after installing version 5.00. 
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5 Uninstalling Online Filing 

If you decide you no longer want to run Online Filing on a specific computer, you can uninstall the software 
completely. 

Uninstalling the server or the stand-alone version 

1. Save your applications and templates as well as the Address Book with the Export functions in File 
Manager and Server Manager, see Backing up data (p. 43). 

2. Uninstall the software, see Uninstalling the server (p. 46). 

3. Remove any files you no longer need, see Removing OLF program files and folders (p. 48). 

4. Delete the Online Filing keys in the Windows registry, see Editing the Windows registry (p. 49). 

Uninstalling the thin client 

Windows 7 and Windows Vista: 

 Open the Windows Control Panel. 

 Go to Programs > Programs and Features > Uninstall or change a program. 

 Select Online Filing Client 5.0 and click Uninstall/Change. 

 

Figure 51: Uninstalling the OLF thin client in "Uninstall or change a program" in Windows 7 and Windows Vista 
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Uninstalling in Windows XP: 

 Open the Windows Control Panel. 

 Go to Add or Remove Programs > Change or Remove Programs. 

 Select Online Filing Client 5.0 and click Change/Remove or Remove. 

 If the thin client was installed with MSI Installer, two individual buttons will be displayed here (Change and 
Remove). 

 Only a single button is displayed if the thin client was installed with the EXE file (Change/Remove). 

 

Figure 52: Uninstalling OLF thin client in "Add or Remove Programs" in Windows XP 

The uninstallation routine starts. 

 Click Next in the Online Filing Client 5.0 Uninstall window. 

 Click Finish in the Online Filing Client 5.0 has been successfully uninstalled window. 

You are prompted to delete the folder EPO_OLF5-TC. 

 Click Yes to confirm. 

 

Figure 53: Prompt to delete the Online Filing thin client program folder 

If you cannot see the prompt, it might be because it is hidden behind other application windows on your screen. 

If this dialogue does not appear, check if the folder Program Files\EPO_OLF5-TC was removed. If you can 
still see it, delete it manually. 
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6 Using the PMS gateway interface 

An installation guide and description of how the PMS gateway works is provided in the Online Filing V5 
development kit. This kit is available under Download-centre > Software > Online Filing related 
software on the EPO's Online Services website (http://www.epoline.org). In addition to documentation, the kit 
also contains the necessary program files, Java classes, and DTDs. 

Important information on using the PMS gateway 

 The PMS gateway interface is activated under System Preferences in the OFL File Manager. Activation is 
only possible if user management is also enabled in OLF. 

 A smart card that has been approved and registered by the EPO must be inserted in the OLF server 
computer's reader to send applications to the EPO. 

 In a local installation, PMS gateway access is only possible if the OLF File Manager is active. 

 The OLF client's GUI blocks when the system is processing a PMS request. The EPO recommends installing 
two different OLF instances for PMS use and GUI use, if you want to simultaneously operate a PMS with the 
gateway and OLF via the GUI in your company.  

 Certain validation messages (GUI-specific validations) are only outputted in English. 

Importing PMS data in OLF 

For a detailed description of the import data requirements, refer to the document "Importing Data into Online 
Filing version 3.20 (release 3.80) and higher" available under Download-centre > Documentation > Online 
Filing documentation on the EPO's Online Services website (http://www.epoline.org). 

 

http://www.epoline.org/�
http://www.epoline.org/�
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6.1 PMS gateway features 

The PMS gateway uses OLF Web service commands that match the basic functions of the OLF client: 

Web service 
command 

Explanation 

validate Checks and validates data in an application using the OLF software verification rules 

import Imports an application from the PMS into the OLF database. 

sign Signs an application. The digital signature for non-repudiation is applied prior to 
transmission via a smart card inserted into a reader connected to the OLF server. A soft 
certificate can alternatively be used for this. 

send Sends an application to the receiving office. 

export Exports an application with all associated data from the OLF database to the PMS. 

remove Removes an object from the OLF database. 

information Exports data, including log files, to the OLF database for all or specific applications. 

 

PMS requests for OLF Web services are always processed sequentially by the PMS gateway, meaning they are 
routed to a queue and then processed one after the other. 

For more information, refer to the document "Introduction to the PMS Gateway Interface" supplied with the 
above-mentioned development kit. 
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6.2 Technical coordination with the EPO 

Enabling the Patent Management Systems (PMS) gateway interface requires prior approval of the PMS software 
by the patent office(s) where an application is to be filed. Using the PMS gateway interface without prior approval 
of the software may result in malfunctions or technical/procedural errors. 

In the case of standard PMS software, the supplier may already have obtained the necessary approval. For 
custom-made PMS software, or where no approval has yet been obtained for the standard version, approval 
must be obtained from the support desk(s) of the patent office(s) concerned. With regard to the EP F1001 and 
PCT/RO/101 procedures, approval must also be requested from the EPO support desk before patent offices are 
contacted. 

Please refer to the latest information on the EPO's Online Services website (http://www.epoline.org), before 
activating the PMS gateway and filing applications. 

Testing the PMS gateway 

Start by performing a test in demo mode. This sends data to the demo database on the EPO's OLF server. 

 Log on as an administrator and start the OLF File Manager in demo mode. 

 User management is enabled if you log on here with your username and password. 
 If not, go to Tools > Preferences > System Preferences and select the check box Enable User 

Management.  
 Activate the PMS gateway interface with the Smart card option under System Preferences. 

 Use your PMS to submit a couple of demo applications to the EPA. You can use the EPO's sample 
applications for this as they contain all the relevant data. 

 Monitor the response from your PMS.  

If everything works as expected, contact EPO User Support for further coordination. The support desk checks the 
demo applications received and reports any technical malfunctions that may have occurred. You are then 
granted a release for your PMS software. 

For the verification of procedures other than those filed or accepted by the EPO, please contact the relevant 
patent offices immediately and inquire directly about the CP approval procedures. 

Activating the PMS gateway for filing in production mode 

 Start the OLF File Manager in Production mode. 

 If necessary, enable user management under System Preferences. 

 Then go to the PMS gateway interface under System Preferences and activate the Smart card option. 

 Select the check box I confirm that the PMS software has been approved by the patent office(s) 
concerned. 

 Select the check box Enable filing to production. 

This now lets you send your applications from the PMS to the EPO and the other patent offices over the PMS 
gateway interface. 

 

http://www.epoline.org/�
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7 Troubleshooting 

The OLF 5.00 installation also includes services for the server and the Firebird (InterBase) database. In server or 
stand-alone installation mode, the OLF system creates and starts  

 a service for the File Manager 

 one service for each procedure, irrespective of whether it is in production or demo mode. 

 

The OLF related services can be monitored via: 

 the OLF Server Manager 

 the Windows Services Manager to be found in Control Panel > System and Security > Administrative 
Tools > Services. 

 

 

7.1 Checking and verifying installation of the stand-alone version 

For complete stand-alone installation of Online Filing the following devices and applications should be on your 
PC: 

 GemPC Twin smart card reader (hardware) 

 GemPC Twin driver (normally automatically installed if the GemSAFE Libraries were installed and the smart 
card reader was connected to the computer)  

 GemSAFE Libraries Version 4.2.0 SP4 (5.2 Patch 1 for Windows 7 and Windows Vista) 

 Adobe Acrobat Reader, Version 9.x (versions 7.x or 8.x are also supported) 

 Arial Unicode MS Font, Version 0.86 or higher 

 Amyuni PDF Converter 3.0.3, if required 

 Online Filing client 

 

 Check your Windows Programs menu for the EPO Online Filing program group. 

 

Figure 54: Program group "EPO Online Filing" exists (stand-alone version) 
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7.2 Checking and verifying installation of the network version 

7.2.1 Checking and verifying the server PC 

 Check your Windows program menu for the EPO Online Filing program group. 

 

Figure 55: Program group "EPO Online Filing" exists (network version) 

 Check that the services shown in the Services tab of the Server Manager are all running. 

 

Figure 56: Server Manager - Services tab 
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Alternatively, you can check in the Windows Services Manager under Control Panel > System and Security 
> Administrative Tools > Services. The EPO OLF services should be running for all forms. 

 

Figure 57: Checking eOLF services in Windows 

To verify that the ports are available, you can check in a DOS box. 

 From the Windows Start menu, select Accessories > Command Prompt. 

 Type the command netstat -an. 

You can see here which ports are currently open on your server. The ports used by the OLF server, such as 
11000, should all have LISTENING status. 

 

Figure 58: MS-DOS command "netstat -an" 
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7.2.2 Checking and verifying the client PC 

To check that the network connection to the server machine is possible, you can also do that at a DOS prompt 
with the MS-DOS command ping. 

 Open the Command Prompt. 

 Type the command ping [IP address of your Online Filing server]. 

Example: ping 10.0.3.24 

The result should be a response from the server machine without any error messages. 

 

Figure 59: MS-DOS command "ping" 
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7.3 Optimising the display settings 

Please note that Online Filing was optimised for display with the normal font size. Notebook computer users often 
choose a larger system font to make on-screen text easier to read on smaller, high-resolution displays. If you 
notice when working with Online Filing that some of the text in screen masks is missing or truncated, please 
change your settings as follows: 

Windows 7 

 Open the Control Panel  

 Go to Appearance and Personalization > Display. 

 Select the Smaller - 100% (default) option. 

 Click Apply. 

You must log off your computer to activate the new settings. 

Windows Vista 

 Open the Control Panel. 

 Go to Appearance and Personalization > Personalization. 

 Click Adjust font size (DPI) in the Tasks area. 

 Click Continue in the User Account Control window. 

You are prompted to enter an administrator password here if you are not logged on as a Windows 
administrator. 

 Select the Default scale (96 DPI) option. 

 Click OK. 

You must restart your computer to activate the new settings. 

Windows XP 

 Open the Display option in the Control Panel. 

 Click the Appearance tab. 

 Set the option for Size to Normal. 

 Click OK. 

The modified settings take effect immediately.  
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7.4 Setting up your office firewall for OLF 

! Note: To do this you must be the network administrator. 

Online Filing uses the HTTPS protocol over the standard port 443. In your firewall, that port needs to be opened 
for the IP addresses required by the various OLF services that your company uses. 

To get the IP addresses for the configuration of your firewall, you need to know the host names of all receiving 
servers. Check with your colleagues which patent offices they will be using OLF to file to. 

You can find information about the filing offices in the Maintenance Tables of the File Manager. 

 Start the File Manager by clicking the Online Filing Client 5.0 shortcut. 

 In the menu bar, select Tools > Maintenance Table Viewer > Common Maintenance. 

 In the Maintenance Table Viewer go to Filing Offices. 

 

Figure 60: Maintenance Table Viewer listing the Filing Offices 

 Select the office that you require from the list on the right of the screen 

In the lower part on the right the details for the selected procedure are listed: code, office, description, name 
of filing office, production server url and demo server url. 

 You can copy the hostname from the field Production Server url.  

 Highlight the name with your mouse, then right-click and select Copy from the shortcut menu. 

 Paste that name into a text file if you wish to save it for further use. 
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 Look for the IP address if your firewall needs an IP address rather than a host name.  

You can search one of the IP lookup services on the Internet or use the command ping, see Checking and 
verifying the client PC (p. 66). The filing office's server will probably block the ping request but will return the 
IP address. 

 Open port 443 for that IP address. 

 Repeat the above steps for all filing offices concerned. 

 

Figure 61: Pinging the receiving server to retrieve its IP address 
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8 Glossary 

CORBA 
Common Object Request Broker Architecture: 
defines cross-platform protocols and services, 
eases development of distributed applications in 
heterogeneous environments. 

Default 
An automatic selection made by the system when 
the user does not specify an alternative. 

Firebird SQL database server 
Firebird is a simplified Open Source spin-off of the 
InterBase relational database management system 
produced by Borland. 

GUI 
Graphical User Interface: software component 
allowing user interaction with graphical elements in 
the program via a mouse and keyboard. 

HTTP 
HyperText Transfer Protocol: method of transferring 
information on the WWW, usually in HTML. 

HTTPS 
HyperText Transfer Protocol Secure: indicates that 
HTTP is used with a different port (443) and an 
additional encryption/authentication layer between 
HTTP and TCP. 

Icon 
A small image displayed on the screen that allows 
the user to control certain computer actions without 
having to remember commands or type them on the 
keyboard. 

IIOP 
Internet Inter ORB Protocol: defined in CORBA, 
used to execute remote procedure calls. 

LAN 
Local Area Network: typically within one building of 
a company. 

ORB 
Object Request Broker: agent enabling 
communication between objects within a distributed 
system, for example the Internet. 

Patch 
A new feature or function added to a program, 
commonly used as an interim measure before 
release of a full version of the software. 

PDF 
Portable Document Format: A file format used in 
saving documents. It can be read using free PDF 
Reader software. 

 

PIN 
Personal Identification Number: PINs are used for 
transmitting information electronically over a secure 
internet link. 

 

PMS 
Patent Management System: Software for the 
administration and filing of patent applications, 
generally based on a database. 

Port 
A port is part of a network address for a server 
application running on a computer within the 
network. Typical ports are 80 for HTTP Web 
servers and 110 for POP3 mail servers. 

Proxy server 
A firewall component that manages Internet traffic 
to and from a network. 

SOAP 
Simple Object Access Protocol: using XML for data 
display and mainly HTTP for transmission. 

SSL 
Secure Socket Layer: A protocol developed by 
Netscape Communications Corporation for ensuring 
security and privacy in internet communications. 
Supports authentication of client, server, or both, as 
well as encryption during a communication session. 

TCP 
Transmission Control Protocol: Used to manage 
data exchange between computers via network 
connections. 
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URL 
Uniform Resource Locator: An address for a 
resource on the internet. Used by Web browsers to 
locate internet resources. 

 

WAN 
Wide Area Network: normally across several 
offices/subsidiaries of a large company or 
organisation, including Internet connection parts in 
between.  

Workflow 
The tracking and management of all activities from 
start to finish. 

XML 
eXtensible Markup Language: XML is a document-
processing standard officially recommended by the 
World Wide Web Consortium and widely accepted 
throughout the internet community. It provides a 
way to define and manage information. It can be 
used to check the accuracy and quality of 
documents. 
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